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Min. PC Specification
(O
CPU
Memory
16ch ~ 32ch

Video

HDD
Resolution

Mid. PC Specification
0S
CPU

Memory

32ch ~ 64ch _
Video

HDD
Resolution

Recommended PC Specification
(N
CPU
Memory

64ch ~ 128ch ,
Video

HDD
Resolution

[Recommended Specification]

Windows
win10 (32/64bit)

10.12 (Sierra)

Linum(ubuntu)
ubuntu 14.04 LTS ~

6th Gen. i3-6300(3.8G)

MacBook Pro 13" (2016)

6th Gen. i3-6300(3.8G)

8GB

8GB

8GB

Built-in Graphics
(HD Graphics)

Built-in Graphics
(IRIS Graphics)

Built-in Graphics
(HD Graphics)

500GB~1TB 256GB~ 500GB~1TB
1920x1080~ 2880x1800~ 1920x1080~
Windows MacOS Linum(ubuntu)
win10 (64bit) 10.12 (Sierra) ubuntu 14.04 LTS ~
8th Gen. i7-8700(3.2G) | MacBook Pro 15" (2016) | 8th Gen. i7-8700(3.2G)
16GB 16GB 16GB

NVIDIA GTX 1660~
(Memory 6GB~)

Radeon R9 M370X~
(Based on MacBook
external Video)

NVIDIA GTX 1660~
(Memory 6GB~)

500GB~1TB 500GB~ 500GB~1TB
(2K) 2560x1440~ 2880x1800~ (2K) 2560x1440~
Windows MacQOS Linum(ubuntu)
win10 (64bit) 10.12 (Sierra) ubuntu 14.04 LTS ~
11th Gen. i7-11700(3.6G) | MacBook Pro 16" (2019) | 11th Gen. i7-11700(3.6G)
32GB 32GB 32GB

NVIDIA RTX 2070~
(Memory 8GB~)

Radeon R9 M370X~
(Based on MacBook
external Video)

NVIDIA RTX 2070~
(Memory 8GB~)

500GB~1TB

500GB~

500GB~1TB

(4K) 3840x2160~

2880x1800~

(4K) 3840x2160~




1. UVMS
1.1 Login

1) Login

— Connect to UVMS with user ID and password
2) User Name

— Input UVMS user ID
3) Password

= Input UVMS user password

— If the password is incorrect more than 5times, the account will be locked for 1Iminute.
4) Auto Login

— Check to use Auto Login
5) Save User Name

— Check to save user ID

1.2 Splash

— If Auto Login is set, you would see only splash screen when UVMS is started again.



1.3 Main Layout

1.3.1. Main layout menu

Close all Channels
Close the selected sites

Close the selected channels

Channel Setting
Channel Function
Display Mode

Image recording (AVI) On/Off

Thumbnail Search

Bookmark

Go To Playback

Panoramic View
Stream Type
Show Text

Add Layout to Favorites

11) Panoramic view

Main layout is composed of top panel, left panel, right panel and bottom panel.

1) Close all channels

- Close all channels on UVMS

2) Close the selected sites

- Close the selected sites on UVMS

3) Close the selected channels

- Close the selected channels on UVMS

4) Channel Setting

- Set the channel's camera type/nickname/comment

5) Channel Function

- Go to D-Zoom/PTZ/Capture/Print/Thermal/Environmental
Sensor

6) Display Mode

- Goto ViewAll/1, 4, 9, 16 screen mode

7) Image recording(.AVI) on/off

- If there is the channel to record, focus the channel and
click ‘Image Recording(.AVI1)’ then it will be saved as AVI file
8) Thumbnail search

— Search a specific channel with multiple thumbnail images

in 1 hour, 2 minutes and 4 seconds unit.
9) Bookmark

— Save channel information, date/time, and comments
10) Go to live / playback
- Go to live or playback mode

- Select channels and make a panoramic view

12) Stream type

—  Choose stream type to display — Auto stream, 1st stream and 2nd stream

13) Show text

— Choose the text to display: Site name, channel title, mode, date/time, resolution and

bottom background
14) Add layout to favorites
— Make current layout to favorite layout



1.4 Top Panel
Lyt | (
Icon Name Description
Top menu bar Backup, Configuration, etc.
UVMS Logo
Layout tab
Close layout
Add layout

Tab sequence

Tab Sequence Movement

Program Shortcut

Screen Record

Record UVMS operation

Volume control

Control UVMS audio volume

Turn ON/OFF Volume

Two-way audio

Two-way audio ON/OFF

Configuration

Help

Version Information / UVMS Update and Reinstall

Fit the Size

Adjust the UVMS screen size

Minimize

Full Screen

Exit

RIGEL IS o] i g

1.5 Left Panel

Name Description
UVMS Logo
Device Search device or cameras by
search entering its name
Device list Registered site list
Favorite Save the current layout into
favorite

Hide/Show Hide and show left panel

Popup For details, refer to ‘1.5.1 popup
Menu menu’




15.1.

1)
2)
3)
4)

5)

6)

7

8)

1.6

1.7

Popup Menu

Site refresh : Refresh site list

Add/Edit site : Show the ‘Site Add /Edit’ popup window

Import/Export : Import and export site list

Channel Setting

— Set the channel's camera type/nickname/comment

Live

— Choose a site list and click ‘Live’ to see the live view of all cameras in the site

— Choose a camera of site list and click “Live” to see the live view of that camera

Playback Open

— Choose a site list and click ‘Playback Open’ to see the playback of all cameras in the
site

— Choose a camera of site list and click ‘Playback Open’ to see the playback of that
camera

Remote Setup

— Connect to the Setup Page of Web

— Access after entering ID and PW

Site Backup : Show schedule backup window

Right Panel
Icon Name Description
. STATUS Check the health status per device
. LOG System log, device log, LPR log
] 1 Mode 1 screen split mode
I 4 Mode 4 screen split mode
9 Mode 9 screen split mode
—. 16 Mode 16 screen split mode
1" View All Screen
II Channel shift Move to previous and next channel
] Full Screen Monitoring with full screen
. Sequence Sequence by split-screen
. Back Back to the previous mode

Bottom Panel

Name
Go to first play / last play

Backup Player
Calendar

Skipping playback
Date and time
Speed Control
Playback Control




Zoom

Focus
Iris
Speed Low

Preset 1
Guard Tour

Relay |1

9 Lve

7 Snapot

re
) Slvayme

-~
v Lypoit oyne

Name Description
Zoom In/out
Focus +/-
Iris +/-
Speed Normal, Low, Fast
Preset preset setup and move (1~199)
Guard Tour Move to set presets in sequence
Relay Send Relay signal
LIVE Move the timeline to the current time
Site sync Synchronize all channels of same site
based on focused channel
Snapshot Snapshot ON / OFF

Layout sync

Synchronize all channels of all same sites
based on focused channel




2. Registration
2.1 Site List
2.1.1. Site Add/Edit (1/2)

1) Site search function
— Search all devices connected to network automatically
— Refresh for new device
2) Site add function
— Choose connected device which want to add, and click ‘Add’ button

— When choose ‘Add’ button, password input window is open.
— User input password of device to connect.

— If device registration is successful, connected device is showed up on registered



sites list and device information is shown in the below.

3) Site edit function
— Click information column to modify.
— If user edits the number of channel, it is displayed as the number of channel which
user sets
— Click ‘OK’ button to complete edition.

2.1.2. Site Add/Edit (2/2)

1) New group
— Add new group in the list
- Add new group at the out of existing group when you check ‘Add to Root’
2) New Site
— Add new site manuall

— Input IP Address, Port, Web Port, User ID and Password
— After inputting the device information, click ‘Verify'. If the information user entered is
correct, Site name / Channel / Mac. / Version information will be shown as below
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3) Rename
— Edit group or site name
4) Delete
— Delete the group or site
5) Change Group
— Move group or site into other group
6) Move up
— Site name goes up in the list
7) Move down
— Site name goes down in the list

2.1.3. Site List

1) Site list

— Once Add/Edit site process is done, site list will be shown.

2) Layout open (site)

— If you drag sites on layout, all cameras included in the site will be
displayed

3) Layout open (camera)

— If you press Ctrl + left mouse button click or Shift + left mouse button
click on desired cameras and drag on the layout, those selected cameras
will be displayed

PR s | e w1

2.2 Favorite
2.2.1. Favorite

Close all Channels

Close the selected sites

Close the selected channels 1) Add the current screen to ‘Favorites’ menu
Chatinel Setting 2) After making your own layout and clicking right mouse button,
Channel Function choose ‘Add Layout to Favorite’ to create your own favorite layout

Display Mode
Image recording (.AVl) On/Off

Thumbnail Search
Bookmark

Go To Playback

Panoramic View
Stream Type
Show Text

Add Layout to Favorites
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2.2.2. Add Favorite

1) When you choose ‘Add Layout to Favorites’, favorite
name edit window will popup

2) Enter the name and then the favorite name will be shown
up at left panel

2.2.3. Open Favorite

— Layout 1

( S, 1) In case of dragging created Favorite on the layout
= UVMS wniversal vms window, a new layout tab with the same layout name will be
shown up

2) While a Favorite Window is open, you can add more
cameras and rearrange the layout

Vv Bm Site
B My Sites
B> B My Sites
B My Group
V B3 Favorite
> Y [18] Layout 1

2.2.4. Delete Favorite

1) Edit favorite list
After right mouse button click on the title of favorite list, you

can remove it by clicking ‘Edit favorite list — ‘Remove Favorite’

¥ If user wants to rename the favorite, click ‘Rename Favorite’

2) Favorite Scheduler

After right mouse button click on the title
of favorite list, you can set schedule by
clicking ‘Favorite Scheduler’

Day/Time to monitor can be set with
mouse drag.(Colored with Yellow.)
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3. Live
3.1 Open Live Screen
1) After registering the site, dragging the site to right to connect
2) If the site is connected normally, a live screen is displayed.

r

3.2 Close Live Screen
1) To close the site, mouse right-click on live screen
2) Select wanted closing type: all channels / selected sites / selected channels
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T i

Icon Name Description
Information Information of channel
PTZ 8-direction Zoom in/out
D-Zoom Digital Zoom in/out by using wheel of mouse
Print Print current channel
Snapshot Capture current channel
Close Close the channel
Select Selected channel is changed into yellow color

Multi Channels could be selected by mouse dragging

Channel status

Status of current channel, PTZ, D-zoom, Date/Time
and Resolution

Dropdown

When the screen is small, the top menu is shown in
‘Dropdown’ type
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4. Channel Setting

“hannd Bumbe

Thannel Tew
Channel Bickname office

Channel Comment

[ oetaue

- Click the right mouse button on the site list or display channel and select ‘Channel Setting’ to
setting the channel

- Set camera type, nickname, comment and so on.

- Camera Type : Normal, PTZ, Fisheye

4.1 Fisheye (* Only OpenGL mode is available)

- Change camera type to Fisheye

- Camera detail can be set as Ceiling/Table/Wall. And Offset/Ellipticity can be set by button
control.

- Mouse operation can change round image to flat image.
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4.2 Fisheye Panorama

- With the mode icon in the channel, display mode can be changed to normal fisheye mode and
Panoramic mode(90°/180°/360°).

- Move the channel image with mouse drag operation and see the wide spread image.

- Zoom In/Out can be controlled by mouse wheel.
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5. Bookmark

- Open Bookmark screen through the pop-up menu on the open channel or time table.

- Save channel information, date/time and comment.

- When the bookmark is opened in the channel, the current data/time is set. When the bookmark
is opened in the time table, the date/time of the clicked position is set.

- After saving, date/time and comment can be adjusted in the list.

5.1 Bookmark Play

- Select the bookmark in the list and drag/drop it to the main layout to play.
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6. Masking Tool

(1) Click ‘Masking Tool’ in the menu(Configuration > Application)

(2) Import saved image and apply masking for the desired position by mouse drag and save.
(3) Remove masking position with ‘Clear’ button.

(4) Cancel masking position step by step with ‘Revert’ button. (Max. 10 times.)
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7. Display
7.1 Zoom

1) Zoom in/out can be controlled by mouse wheel operation
— Wheel up and down for zoom in and out of the screen
— If you Zoom in the screen, the stream will be changed from sub into main
— In the Zoom-in screen, screen is moving as zoomed-in status.
— If you double click at the background, the layout will be rearranged

7.2 Free

1) Channel Swap
— Two channels are interchangeable
- Changing with dragged and dropped channel

2) Adjust channel size

- If the mouse curser is located at the corner,
the curser will be changed and the screen
size can be adjusted.
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[2-9) FN-51 [2-10] FN-£

2-13] FN-% [2-14) FN-%

3) Free Screen layout
— User can change the size of the screen and position as user wants
— Default is standard split mode
4) Display
— Choose multiple channels by mouse drag
— Citrl + left mouse button to choose multiple channels
— Enlarge or shrink display size by using wheel of mouse
— Double click to make the channel in full screen mode

7.3 Split Screen Mode

1) 1 screen split mode 2) 4 screen split mode

O oms

3) 9 screen split mode 4) 16 screen split mode

0 s i | S
s
|

sy

— All screen : Rearrange all channels on current layout
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7.4 Group

1) While the multiple sites are displayed, user can classify which channels are in the site by
clicking left mouse button for about 2~3 seconds. Border line color will be changed into
blue
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8. Menu on the Top(Upper Left)
8.1 Widget(*Windows Only)

Layout 1

Add Layout
Add Widget Clock

CPU

Event Popup Run
Memory

LogViewer Run
E-MAP Run
File Backup Run

Thermal

Environment
Backup Player Run

Configuration
About

— Inthe top menu, add clock, CPU and memory widget on the screen.
— User can change the size and position of widget as user want.

8.2 Layout

Layout 1

Add Layout Monitoring Layout
Add Widget

Event Popup Run
LogViewer Run
E-MAP Run

File Backup Run
Backup Player Run

Configuration
About

(1) Add Layout
— Click ‘Menu > Add Layout > Monitoring Layout” to create new layout.
— Click +"icon on the top.
(2) Layout Sequence
— Click Sequence icon.
— Interval can be set in between 5~3,600seconds in the menu(Configuration > Display)
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8.3 Event Popup (1/2)

1) Open Popup Screen
— Click ‘Event Popup Run’.
— When the event comes to UVMS, the related channel pops up in the popup screen.
And playback for the channel and information checking is available.
2) Event Thumbnail
— The last 7 events are shown in the screen.
— When the thumbnail is clicked, related information checking and playback is
available.
— Channel size can be adjusted
3) Default Split
— Make the current screen as a default.
4) Event List
— Show event list.
— Each event can be playback by double click on the list or click playback in right
mouse button menu.
— All events or each event can be deleted with right mouse button click.
— Adjust column to display can be selected with right mouse button click.
— Event list order can be controlled.
— No. of event received can be checked.
5) Playback
— Playback can be done from the event thumbnail or event list.
— Image control(Zoom, Capture, Record & Play) is available.
6) Information
— Information on the event which is selected in the list is shown.
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8.4 Event Popup (2/2)

1) Event To Receive
— It shows the event list which will receive at UVMS.
2) Event List
— Click ‘Edit’ button
— Select Event to receive and click ‘Event Add’ button.
— Select Event not to receive and click ‘Remove’ button.

8.5 E-Map
8.5.1. E-Map Main Layout]

(1) Top Menu

- E-Map Name

— E-Map System Information
(2) Left Panel

— Site Search

— Site List

— E-Map List



(3) Right Panel
- ALL
- CCTV
- ALARM
— SENSOR
- EDIT
- SEARCH

(4) Bottom Panel
— First Data Play
— Last Data Play
— Calendar
— Skip Play
— Search/Play
— Search/Play Controller
— Time Table

8.5.2. E-Map Open & Edit

1) Addition

— Click ‘+’ button on the top and add E-Map

— Image File format should be .PNG or .JPG.

— Image Size should be in between 4000 X 2827 ~ 4500 X 3180 pixels.
2) Open

— Drag E-Map title and drop on the layout screen.

— New Tap on the top with the name of the E-Map opened will appear.



3) Image Change

— Right mouse click on the E-Map title and click ‘Edit E-MAP list > Image Change E-
Map’.

— Change image with the same way as E-Map Addition.

4) Rename
— Right mouse click on the E-Map title and click ‘Edit E-MAP list > Rename E-Map’.
— Change name and click OK to save.

5) Delete
— Right mouse click on the E-Map title and click ‘Edit E-MAP list > Remove E-Map'.
— Click ‘Yes’ to delete.

8.5.3. E-Map New Object & Edition

1) New Object
— Channel Drag: Select a channel and drag/drop on the layout
— Edition: Cilck ‘Edit > New Object’ and make an object on a layout by mouse drag.
And input information on the Site/Channel for the object and click ‘Save’.
2) Edit
— The function for moving the location and changing the information of the object.
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— Click ‘Edit’ icon to go to edit mode.
— Click ‘Save’ to save the information.

8.5.4. Edit Mode

New Object

Location

X:| 291 Width: | 47

Y: -89 | Height: | 73

Object

Object Color #96969696

Object Name Elevator

Site/Channel

Site Name | FNR-3004

IP Address 20.255.137.244
Port 9010
MAC

Channel 1CH

Type CAMERA

@ Delete

Drag Mode

8.5.5. Edit Mode Function

(1) Obiject Size Control

[% Save

— Adjust size of the object
— In edit mode, select object and adjust size by mouse drag

1) Location

—Shows location and size of the object

—Control Angle by L, R button click or mouse control on
the object

2) Object

—Set color or name of the object

3) Site/Channel

—Select site/channel for the object

4) Type

- Set the type of the object and display it as an icon.

- If anicon is clicked on the upper right panel, only the
related object on the layout is shown.

5) Delete

- Delete the object

6) Mouse Mode(with right mouse button)

- Select mode: Select object and see image

- Drag mode: Control/Move the layout
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(2) Object Angle Control
— Adjust angle of the object
— Angle can be controlled by the right mouse click on the object.
— Also can be controlled by B button in the panel.

(3) Change location
— Select object with the mouse and move it to the other position
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(4) Multiple Selection and copy
— Multiple object selection is available with ‘Ctrl+click’ or mouse drag.
— Aobject can be copied with ‘Ctrl+C’(copy), ‘Ctrl+V’(paste))

8.5.6. View Mode

1) Top Menu

— It shows status of the map

— Name and the number of Object, CCTV, Alarm & Sensor
2) Right Panel

— Select the type of the object to show on the layout
3) E-Map Play

— When the object is clicked, the live image is shown.

— With the bottom panel, the recorded image of the object can be playback.
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8.5.7. E-Map Search

1) Search Panel
— Input keyword to search the related object.
— Select an object in the searched list to see the location.
2) View Location
- When itis clicked, arrow icon is shown on the layout and user can easily find the
location of the object
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9. Playback
9.1 Playback Extra Features

1) Date/Time
— Display the date and time on focused video
— If there is no data in Playback mode, the time and date of live will show
2) Playback Controller
—  X(-64) backward ~ x64 forward playback
- Control the playback speed by slide bar
— Goto first data and Go to last data
3) Skip Play
— Ifitis selected, playback is done by skipping frame with the selected speed.
— Change skip play status works after making current playback stop and start.
4) First Data / Last Data Playback
— Playback of the first data or the last data.

5) File Player
— Refer to “14.9 File Player”.
6) Indicator

— Default : Show date and time of the currently focused channel
7) Live (Button)

- Move to current time line(as a live view)
8) Site Sync (Button)

— On: Sync all channels (Control at the same time)

— Off : Control only focused channel

¥ Tip
1. Same time playback of whole channel
: Choose the channel > Playback > {to) LIVE g Site sync
Site sync
2. All channel Live P
: Choose the channel > Live - Site 3 Snapshot =/ Layout sync
sync

9) Layout sync

— Sync all channels based on the focused channel.
10) Snapshot

— Shows preview images for the channel.
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11) Calendar

Date which has recorded data is showed in yellow

Choose date and time, and click search icon

— Click calendar icon : on/off

- Playback from wanted time

- Choose the date in the Calendar and enter time to go, and click
search icon

12) Time table

- By controlling the mouse wheel on the timeline, you can see the recorded data from
day unit to second unit

— When you drag mouse, you can move scroll bar

— It will be shown if there is recorded data

— Orange : Continuous

— Green : Alarm, Event

— Red: Panic
13) Two Time Tables

— If there is recorded data, it will be shown on the time table.

— Upper Line : Time table for the current selected channel

— Bottom Line : Whole time table for a group.

— When you choose a specific time, recorded data of that time is played
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9.2 Playback Icon

Icon Name Description
red > Rewind / Fast forward
I . Back frame / Forward frame

< 2
(!) [:: Pause / Play
.’l‘ (;:. Skip 10 seconds Skip the frame by 10 seconds
') o 4

& Zoom Click the icon and zoom in/out with mouse dragging

- Original screen is displayed on bottom right
-‘-‘6] Capture Create UVMS Agent window
Q0 Recording If click the recording icon, ‘Recording’ word is displayed

on right bottom. If double click the icon, recording data is
saved as AVI file
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10. Panorama
10.1 Panorama

LIy

1) Time is displayed based on the first selected camera
2) Resolution is displayed by combining all cameras
3) Horizontal, vertical and quad-screen mode are available
4) Panorama add
— Citrl+ left mouse button click to choose 4 channels
— After selecting channels, click the right mouse button and then click ‘Panorama View’
on the popup menu.

10.2 Panorama Type
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1) There are 3 types of Panorama: Horizontal/ Vertical/ Quad mode.
2) Max. 4 Channel could be selected

Horizontal mode

Vertical mode

Quad-Screen mode

Max. 4x1

Max. 1x4

Max. 4x4
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11. PTZ
11.1 PTZ

1) Goto PTZ mode

— When you click PTZ icon, the color of icon is changed into blue (Activation)

2) PTZ move

— If you click your mouse to the direction which you want, the arrow will be highlighted

3) PTZ speed

— If you position the mouse for the direction which you want to move and drag the

mouse, moving speed is faster and the shape of the arrow will be changed

11.2 PTZ Panel

1)Zoom

- PTZ zoom in/out

2)Focus

- PTZfocus control

3)Iris

- Adjust the quantity of light

4) Speed

— Set PTZ speed (Low, Normal, Fast)
5)Preset

— Choose PTZ preset (Available from 1 to 199)
6) Preset Go

— Go to chosen PTZ preset

7)Preset Set

- After positioning preset, choose preset number and set
8) Guard Tour

- Tour as preset

9) Relay

- R1~R4 : Relay #1~#4

- +: Relay Start, - : Relay Stop

- Relay operation is set at the device
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12. Right Panel
12.1 Device Status

1)
2)

3)

4)

5)
6)

7

¥H¥H w2l YmEd

Status
— Show the current status of connected device on UVMS
Site name
— Site name, IP and information. If the information is incorrect, it will not be activated.
Camera
- Check connection status of camera
Icon Description
e Video in
o wf = No video or loss
PR . | Motion in
Relay
— Relay Status of connected site
Icon Description

a

Connected relay

=

Operating relay

REC
Recording Status of connected site
Date/Time
Date and time of connected site
HDD
Total storage, available storage, HDD temperature
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12.2 UVMS Log .

1) UVMS log
— Display UVMS log record
— Can be searched by user, date and time
2) Date/Time
— Choose date and time to search
3) Search
4) Display log of chosen date
5) Export CSV & hmac
— Export currently displayed log record as CSV and hmac
6) hmac certification
— Verify that CSV and hmac files saved on the
computer are original files
— If hmac file is original without modification,
certification window is showed up

12.3 Device Log

1) Device log

— Device log search function

— Snapshot is displayed by double clicking the list, and play record video is available
2) Site name

- Choose the site to search
3) Device log

— Choose the event to search
4) Date/Time

— Choose the date and time to search
5) Search

— Click to search
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12.4 Sequence

1) Layout Sequence
— It displays the layout tabs at the top in order
2) Channel Sequence
— It displays open channels in the layout with the selected split mode in order
— The selected split mode must be less than the total number of channels open in the
layout
3) Sequence Interval
— It can be set in between 5~3600seconds in ‘Configuration > Display > Sequence’

12.5 Full Screen .

el ui?‘ met ! |i?‘ we O
!ﬁf ' 2 i i
" ﬁ P TR I e

!

o} 3

1) Change UVMS into full screen
2) In case of full screen mode, channel screen is displayed on screen without panel
3) Click ESC button to exit.
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13. LogViewer

- Click [Upper Panel > Menu > LogViewer Run] or [Configuration > Network > LogViewer Open]
to open.
(* [Configuration > Network > Save Liver Event Data] should be checked to save log.)

13.1 LogViewer — Data Load

1) Site List

— It shows all sites’ information connected to the UVMS.

— Refresh button makes the list update.

2) Selected Site

- It shows the site name, IP address, Port, Mac, Max. Channel of the
selected site.

3) Data Load

— Search by daily / weekly.

— Select date and click Load button to load data.

— Stop button stops data load.

— If data exists on the day of loading, the date is displayed in yellow on
the calendar. (* Even if the load is successful, the data color does not
change if there is no valid data for that date.)

;eppanpey *

L
- 2
£
.
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13.2 LogViewer — Al Viewer

(* Al Viewer can be used only with the PRISM-AI equipment.)

1) Al Viewer Setup
— Select site and date
— Display pattern or object on that date.
2) Search Result
— Show list of search result
Select an event in the list and click to display image
Image play control by playback controller on the bottom

13.3 LogViewer — Al Dashboard

r "
2N

OO
- -

144182
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1) Al Event Number
— Al events analyzed in PRISM-AI are displayed in numbers
— Change the pattern/object to be displayed by selecting event > Al Object Change >
Apply

2) Date Selection
— Select date that has data shown in the calendar
— After selecting date, click magnifier icon to see Al analysis chart
3) Al Analysis Chart
— Al event analysis data is shown as a chart
— Max. 7 Al event can be registered
— Change the pattern/object to be displayed by right mouse click > Al Object Add/Edit >
Apply

13.4 LogViewer — Al Heatmap

1) Al Heatmap Setup
— Select site & date.
— Select pattern and click ‘search’. Then, the result will be shown as a list in the bottom
box.
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2) Reset
— Al Heatmap setup table reset
3) Export
— Export log list as PNG or CSV file format

4) Search List
— Al Heatmap search result is shown
— Select and click an event in the list to playback the related image.
— Control image playback by controller on the bottom.
— Click ‘show Heatmap’ to show image with heatmap.

13.5 LogViewer — People Counting

1) When there is people counting camera connected, people counting log search is
available.

2) The number of people entering, leaving, passing and their total number can be easily
checked in table and graph.

3) Log search can be done on daily, weekly, monthly and yearly basis.

4) Export log list as PNG or CSYV file format.

5) Click ‘Reset’ to make table reset.
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13.6 LogViewer — People Counting Detail

1)

2)
3)

4)
5)

The number of people entering, leaving, passing and their total number can be easily
checked in table and graph per time.

Log search can be done on daily, weekly, monthly and yearly basis.

Select the channel to search and set the unit of time to be displayed in the graph. And
click ‘Search’ to show statistics at the bottom.

Export people counting detail as PNG or CSV file format.

Click ‘Reset’ to make table reset.

13.7 LogViewer —LPR Log

1)

In case of the device that has LPR registration, LPR log search is available

2) Searching log record by selecting device and setting time

Log search is also available by inputting specific car number plate

3) Playing video is available by clicking play icon on the right bottom of still image
4) The registered car number is remained as a log and can be export as CSV file.



44

13.8 LogViewer — GPS, Thermal, Environmental Sensor

1)

2)

3)

GPS
— Click a site and drag it on the layout.
— Search by channel, date and time range selection
— List shows date/time, IP address, Mac address, latitude, longitude and speed.
— GPSlog can be exported as CSV file.

Thermal
— Click a site and drag it on the layout.
— Search by channel, date and time range selection

— List shows date/time, IP address, channel, Mac address, region, type, status and
value.

— Thermal log can be exported as CSV file.

Environmental Sensor

— Click a site and drag it on the layout
— Search by channel, date and time range selection
— List shows date/time, IP address, channel, Mac address, Temperature, Tvoc, CO2,

PM2.5 and PM10.0.

— Value of the factor that is not applied to the connected sensor will be shown as 0.0.
— Environmental sensor log can be exported as CSV file.



45

13.9 LogViewer — Configuration

1) Default > Save : Apply all pattern

2) Select patterns > Save : Apply only for selected
patterns

X Log Viewer Configuration is applied to the following

menu.
1. Al Viewer

2. Al Dash board — Al Object change
3. Al Dash board — Al Object Add/Edit




14. Backup
14.1 Go to Backup Mode

V Bm Site
Vv B My Sites
B> L p—m—

B> Bm My Sites
B My Group Add / Edit Site

Add Layout
Add Widget

Site Refresh

Event Popup Run Add / Edit Custom Site

Import / Export

V E3 Favorite

LogViewer Run B> o [19] Layos

E-MAP Run
File Backup Run

(7
Backup Player Run Playback Open

Configuration Remote Setup

Al 5(192.168.21.129) Site Backup

- InUVMS top menu(ﬂ) click ‘File Backup Run’ or mouse-right on site list and click
‘Site Backup’ then backup window will open.

14.2 File Backup

I3 30300307300 K-

1) File Backup

— Set backup path to save backup file.
2) Backup Time

— Choose the time to backup

— When ‘ALL DAY’ is selected, it include whole day (24hours)
3) Calendar

— The data which has recorded data, it shows in green

— Choose the date to backup
4) Total

— Total file information of File Count and File Size for the currently selected file
5) Refresh

— Refresh all status of file backup
6) Status information

— Once backup starts, it shows status of file download
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14.3 Schedule Backup

1

2)

3)

4)

5)

6)

7

8)

TR

PERRDERRES

nae

-
)
-

Site List

Site list registered on UVMS

Site Information

Display information of current site
Path can be changed

Backup Date

Choose the date to backup
If you check ‘Continue’, you can designate from backup start date to present

Channels to Backup

ALL Channel : Select all channels
Choose the channel to backup

Server Schedule Setting

Set date and time to backup
Backup section is set by dragging or clicking, and then it is displayed in yellow

Backup Runtime

Set backup progressing time

Backup runtime is set by dragging or clicking, and then it is displayed in green
In schedule backup mode, set a backup time of PC

(*PC has to be turned on during runtime)

‘Save’ Button

After set up backup setting and click ‘Save’ button, data is saved on ‘Schedule
Backup List’ tab
Backup starts as soon as click ‘Save’

Start Schedule Backup with OS

Auto start on/off when OS start
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14.4 Schedule Backup List

1) Schedule Backup List
— It shows schedule backup list which is saved on device
— When schedule backup is set up, user can check status of device backup list
— When the list is double clicked, saving path is opened
2) Backup Stop/Run
— Shows current operation status of backup
— Set start/stop with the button
3) Edit
— Schedule Edit
4) Delete
— Delete selected list
5) Overwrite
— Backup overwrite On/Off
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14.5 Schedule FTP Upload

1) Scheduled FTP upload function is supported for stable backup for multiple sites.
% Caution) To use the schedule FTP upload function, the FTP server must be operated
on the backup PC
2) Site Information
- Display information of current site
— Path can be changed
3) Upload Date
— Choose the date to upload
— If you check ‘Continue’, you can designate from backup start date to present
— If you check ‘Latest, it starts from the previous day and proceeds like continuous
backup
4) Channels to Upload
— ALL Channel : Select all channels
— Choose the channel to backup
5) FTP Server Information
— Host: : Enter Backup server IP Address
— Port: Default port is 22, If it is limited, enter another number
— User: FTP server ID
— Password : FTP server Password
— Home Path : Home path setin FTP

¥ After entering all the information, user should check the connection status with the
FTP server by performing Save / Connect Test
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14.6 Schedule FTP Upload List

wl T gl Lt | by B sl

1) The last downloaded file is displayed, not the time of the last data uploaded
2) Auto Delete
— Delete the data which is older than a set number of days (Default is 7 days, Can be
set up to 180 days)
— Basically, 5% of free HDD space is reserved
— Even if the data is within the set number of days, if the storage space is insufficient,
data with the old recording time are deleted.
— After change the days, click “Save’ to apply.

14.7 File Password
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1) Backup File List
— Display a list of backed up files
2) Select File List
— If you select a file to encrypt, it appears in the list
— ‘Status Scan’ shows the status of the current files(Open or Encrypted)
— ‘Delete’ to delete selected list.
3) File Encryption
— Set up the password in backup file saved in PC (*Multi-files are available)
4) Password Change
— Delete or change the password

14.8 Streaming Backup

1) Streaming Backup
— If both start and end time is set, streaming backup menu is showed up automatically
2) Backup Set
— Set ‘Start indicator’ and ‘End Indicator’ where the mouse is currently located
— Date and time is automatically input on backup dialog
- Or designate range with dragging right mouse button
(*Recommend for short time backup)

3) Backup Clear
— Initialize backup setting
4) Device Information

— Display information of current device
— Set the save path
5) Backup setting
— User can choose channel to backup and setup date and time, manually
— When date and time is changed, start and end indicator is moved accordingly
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6) Backup File Setting
— Select the format of the backup file.

14.9 File Player .

1) File Player

— File Drive List is shown when clicking file play icon on bottom
panel (On/Off)

2) File Drive List

— Choose the file to play

— If you choose the file, TTX file is created. And then you can
play the file through UVMS by double clicking the file

3) Create Timetable

- Change SSF file into TTX file to use on UVMS

4) File Password

- If the file has a password, click ‘ File Password’ and input the
password.

5) One/Multi

- Choose play single channel or multiple channels by selection
of One or Multi.
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14.10 Backup Player & AVI Converter

1) Backup Player

— Open Backup Player in the menu(Configuration > Application > Tools
> Backup Player) or select ‘Backup Player Run’ in the top menu.

2) Backup Player — AVI Converter .

— It makes ssf file format to avi file format
— Backup File List : Backup file list is
shown when the folder in the Drive List is
selected.

— Selected File List : Select file in the
Backup File List and double click to send to
the Selected File List. (To delete, select file
and click ‘Delete’ button)

— Selected File Convert : click ‘AVI
Convert’ to convert selected files.
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15. Screen / Video Recording
15.1 Screen Recording
User can record screen with screen recording button. And when user click ‘screen recording’

button one more time, user can set file iath of screen recordini file.

Screen Recording Inactivate Screen Recording Activate

15.2 Video Recording
User can record selected channel’s video as AVI file. If the recording is activated, ‘Recording’
mark is displayed on the bottom of screen.

Close all Channels
Close the selected sites
Close the selected channels

Channel Setting
Channel Function

Display Mode

Image recording (.AVI) On/Off

Thumbnail Search
Bookmark

Go To Playback

Panoramic View
Stream Type
Show Text

Add Layout to Favorites




55

16. Thumbnail Search

User can search recorded video at split screen mode by hour or 2minute units or 4 second units.

Close all Channels
Close the selected sites

Close the selected channels

Channel Setting

Channel Function

Display Mode

Image recording (AVI) On/Off

Thumbnail Search
Bookmark

Go To Playback

Panoramic View
Stream Type
Show Text

Add Layout to Favorites
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17. Configuration
17.1 Application

1) Skin
— Setup UVMS skin type
— 4 Types : Gray-Orange, Blue-Sky, Black-Red and Navy-Sky
2) Language
— Setup UVMS language
— 5 Languages : English, Korean, Traditional Chinese, Italian and Japanese
— Language change for detail process such as file backup, log viewer, event pop-up is
applied after restarting UVMS.
3) Display
— Setup display according to the specification.
— 2 Types : Basic Display(recommended by the operating system), High Quality
Display(recommended if there is an external graphic card installed)
4) Free resizing of display
— On: Even if there is no space between channels, the size of the channels can be
changed freely.
— Off : If there is no space between channels, the size of the channels will not change.
5) Hardware accelerated decoding
— Use software decoding(compatibility) : decoding by software
— Enable hardware accelerated decoding : decoding by hardware accelerated of
GPU(Graphic Card) — display playback speed is improved
6) Auto
— Auto Login: Start UVMS without log-in.
— Auto Close: Close UVMS without pop-up screen
7) Display last connection view
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— On: Display the last connected layout screen, when the UVMS starts.

— Off : Display empty layout, when the UVMS starts.
8) Version Update Alarm

— On: Notify if there is update version.

— Off : Do not notify even if there is update version.
9) Tools

— Open ‘Backup Player’

— Backup Player Export

— Open ‘Masking Tool

17.2 General

1) Export

— Designate default path and backup path
2) Two-way Audio

— Device: Two-way audio for all devices

— Channel: Two-way audio for only the focused channel
3) Security

— Database Encryption
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17.3 Display

1

2)

3)

4)

5)

6)

7
8)

9)

Default Screen Ratio

Setup basic ration of the channel
There are 3 types of ratio > Native, 4:3, 16:9

Default Stream Type

Setup basic stream
There are 3 types of stream type - Auto, 1st Stream, 2nd Stream

Fill the Screen

Fill the Screen (On/Off)

Space

Adjust channel space to fit channel
After change, double click on an empty space of the layout to refresh.

Select Size

Adjust title font size of channel
Adjust icon size

Date/Time Format

There are 2 types of date/time format : YYYY-MM-DD, MM-DD-YYYY
Time format: (*Currently disabled)

Sequence

Set sequence time interval(5~3600[sec])

Display Text

Select information text displayed in the channel

Display Text Color

Select font color
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17.4 Network

1) Reconnect
— Setup the time for retrying connection
2) Live Storage
— Save live image as SSF file.
— Save path can be set.
— Choose whether to save I-frame or full frame.
3) Live Event Data
— Choose whether to save live event data(GPS, Thermal, Environmental Sensor) to
DB.
— Saved live event data can be searched with LogViewer.
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17.5 Status

1) Status Setting

— Set check duration time for status setting
2) Video loss display

— If there is a video loss, the screen can be set to display "video loss" (On/Off)
3) Get health check and recording information

— Choose On/Off.

17.6 Event

1) Screen flickers at Event
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— Setting the alarm color displayed on the channel when an event occurs
— Set duration screen flicker

17.7 Change Password

1) Change current user password
— When login with the initial administrator account password, it recommends
changing password.
— Change password is for change the currently logged in password
— It is for both administrator and user.
2) Change Password
— Click to change
— Current Password : input current password
— New Password : input new password to change
— Confirm Password : confirm the new password
— Set Password : Save new password
3) Update your security questions
4) If the log in is failed due to the incorrect password, the password can be reset after
authenticating the security question.
5) Set Questions

— Save the questions for authentication
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17.8 User Account

1) User account management
— Only ‘admin’ account can access to user account management
2) User list
— Current user list and description
3) User add/edit
— Add or edit user account
4) User delete
— Delete user account
5) Permission
— Setup the permission of each user account
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Thank you!



